
Subject: West Nile virus???-it looks pretty grim around here
Posted by Deej [1] on Sat, 31 Dec 2005 21:07:26 GMT
View Forum Message <> Reply to Message

;But =
Notify=20
  Me When Critical Errors Occur" if you prefer)

  Disable Remote Assistance
  Start > Settings > Control Panel > System > Remote > Untick "Allow=20
  Remote Assistance Invitations to be sent from this computer"

  Fixed Swap File (Virtual Memory)
  Select the Advanced tab of the Systems applet and then select the=20
  Performance settings button. Then select the Advanced page. In here it =

  is possible to customise the Virtual Memory. For custom size, this is=20
  often recommended to be 1.5 to 2 times t

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by Tom Bruhl on Sat, 31 Dec 2005 21:22:26 GMT
View Forum Message <> Reply to Message

he amount of your total RAM =
for=20
  both initial and maximum size. Set this to a fixed minimum and maximum =

  value according to your existing RAM

  Speed Up Menus
  You can use this tip to speed up the Start Menu in Windows XP. You can =

  customize the speed of the Start Menu by editing a Registry Key. Click =

  Start, and then click Run. Type Regedit in the box, and then click OK. =

  Expand the menu in the left panel and select the=20
  HKEY_CURRENT_USER\Control Panel\Desktop folder. Scroll down in the =
right=20
  panel and double click on the MenuShowDelay file. In the Value Data =
box,=20
  change to default value for the menu speed from 400 to a lesser =
number,=20
  such as 1. Click OK.

  Disable Offline Files
  Start > Settings > Control Panel > Folder Options > Offline Files >=20
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  Untick "Enable Offline Files"

  Disable Remote Desktop
  Start > Settings > Control Panel > System > Remote > Untick "Allow =
users=20
  to connect remotely to this computer"

  Disable Internet Synchronise Time
  Start > Settings > Control Panel > Date and Time > Internet Time >=20
  Untick "Automatically synchronize with an internet time server"

  Disable Hide Inactive Icons
  Start > Settings > Taskbar and Start Menu > Taskbar TAB > Uncheck =
"Hide=20
  Inactive Icons"

  Disable Automatic Desktop Cleanup Wizard
  Start > Settings > Control Panel > Display > Desktop > Customise =
Desktop=20
   > Untick "Run Desktop Cleanup Wizard every 60 days"

  Disable NTFS Last Access Time Logging (NTFS Only)
  Start > Run > regedit > HKEY_LOCAL_MACHINE > SYSTEM > =
CURRENTCONTROLSET=20
   > CONTROL > FILESYSTEM Add a new DWORD value -=20
  "NtfsDisableLastAccessUpdate" (without quotes) and set the value to 1. =

  Then reboot to make changes effective

  Disable Notification Area Balloon Tips
  Click Start , click Run , type regedit , and then press ENTER.=20
  HKEY_CURRENT_USER\Software\Microsoft\Windows\=20
  CurrentVersion\Explorer\Advanced Right-click the right pane, create a=20
  new DWORD value, and then name it EnableBalloonTips . Double-click =
this=20
  new entry, and then give it a hexadecimal value of 0 . Quit Registry=20
  Editor. Log off Windows, and then log back on.

  ----------------------------------------------
  Disable CDROM Autoplay
  One of the very important (and well documented) tweaks in Windows =
98SE,=20
  was to disable CDROM autoplay (auto insert notification). Disabling=20
  CDROM autoplay no longer offers a significant performance benefit in=20
  Windows XP, and therefore you do not need to disable it. Just don't=20
  insert a CD during a crucial recording.

  However, if you really want to disable it then here a few different =
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methods.

  Method 1

  Start > Run > Regedit

  HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Cdrom

  Set autorun to 0.

  Method 2

  Open My Computer Right Click on each CDROM and choose Properties Click =

  on the Auto Play tab In the drop down box you can choose the Action =
for=20
  each choice shown in the drop down box

  Method 3

  Go to Start->Run->gpedit.msc Computer Config -> Administrative =
Template=20
  -&g

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by Deej [1] on Sat, 31 Dec 2005 22:16:36 GMT
View Forum Message <> Reply to Message

 monitor" to "Never".

  Set graphic acceleration to full - You can do this by going to your=20
  desktop, right clicking and clicking on "Properties" then on =
"Settings",=20
  "Advanced" and the "Performance" tab. Make sure the Hardware=20
  Acceleration slider is set to "full" to reduce the load on your CPU.

  Disable background applications - Background applications start up =
when=20
  your computer starts up and can use up unneccicary resources. To =
prevent=20
  these from starting up go to Start =BB Run and type "msconfig" in the =
run=20
  box. Click on the "startup tab" and disable (uncheck) programs such as =

  "taskmon", "load power profile", "real player", "office startup",=20
  "winamp agent" and so on. Keep programs like "scan registry", "system=20
  tray" and programs relating to interfacing with your audio card (such =
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as=20
  console software to control its features).

  Disable USB - If you do not have any devices actively using USB in =
your=20
  system (this includes dongles for your software), disable USB as it is =

  known to sometimes cause problems in certain DAW configurations. Not=20
  only will this help to increase system performance, but it will also=20
  free up an IRQ. Right click on your "My Computer" icon on your desktop =

  and select "Properties". Click on the "Device Manager" tab and scroll=20
  down until you see the USB section. Click on the "Properties" for the=20
  USB device and check off "Disable in this Hardware Profile". You will=20
  have to reboot for these settings to take effect.

  Graphical window settings - Go to Start =BB Settings =BB Folder =
options and=20
  click on the "View" tab. Under "Visual settings" check off "Show =
window=20
  contents while dragging. This is more of a usability tweak, as it will =

  allow you to see the contents of windows on the screen as you drag =
them=20
  around (instead of them going blank).

  Disable NTFS Last Access Time Logging (NTFS Only),   Start > Run >=20
  regedit > HKEY_LOCAL_MACHINE > SYSTEM > CURRENTCONTROLSET > CONTROL >=20
  FILESYSTEM Add a new DWORD value - "NtfsDisableLastAccessUpdate"=20
  (without quotes) and set the value to 1. Then reboot to make changes=20
  effective

  J.W. wrote:
  > Hey all, having signifcant problems with Paris Pro 3.0 using Windows =
XP.
  > Had it running just fine with 98se, then upgraded the pc to XP with =
a AMD
  > Athlon X2 3800+, Abit AN8, 2GB RAM, Matrox P650 dualhead, WD 80 GB =
for c
  > drive and 2 WD SATA2 200GB for storageetc..  The best case scenario =
is Paris
  > will sometimes play, but will not record.  Sometimes it comes up =
with the
  > error "cant initialize the engine".  Need some help form you Paris =
guru's.
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  > The pc works great with all other programs, so it is defintely =
Paris.  There
  > is no firewall, internet, antivirus running or installed.  This is =
solely
  > for audio.
  >=20
  >
------=_NextPart_000_01AE_01C61A9C.6C058800
Content-Type: text/html;
	charset="iso-8859-1"
Content-Transfer-Encoding: quoted-printable

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">
<HTML><HEAD>
<META http-equiv=3DContent-Type content=3D"text/html; =
charset=3Diso-8859-1">
<META content=3D"MSHTML 6.00.2800.1400" name=3DGENERATOR>
<STYLE></STYLE>
</HEAD>
<BODY bgColor=3D#ffffff>
<DIV><FONT face=3DArial size=3D2>J.W.</FONT></DIV>
<DIV><FONT face=3DArial size=3D2>Do you have more than one ADAT =
card?&nbsp;=20
</FONT></DIV>
<DIV><FONT face=3DArial size=3D2>Not easy to use with XP.&nbsp; I have =
to, use=20
one</FONT></DIV>
<DIV><FONT face=3DArial size=3D2>in each MEC.&nbsp; 2 ADATs in one MEC =
won't allow=20
</FONT></DIV>
<DIV><FONT face=3DArial size=3D2>Paris to boot up.&nbsp; </FONT><FONT =
face=3DArial=20
size=3D2>18/12 error happens.</FONT></DIV>
<DIV><FONT face=3DArial size=3D2>Tom</FONT></DIV>
<DIV><FONT face=3DArial size=3D2></FONT>&nbsp;</DIV>
<DIV><FONT face=3DArial size=3D2></FONT>&nbsp;</DIV>
<BLOCKQUOTE=20
style=3D"PADDING-RIGHT: 0px; PADDING-LEFT: 5px; MARGIN-LEFT: 5px; =
BORDER-LEFT: #000000 2px solid; MARGIN-RIGHT: 0px">
  <DIV>"John" &lt;<A href=3D"mailto:no@no.com">no@no.com</A>&gt; wrote =
in message=20
  <A href=3D"news:43cb853c@linux">news:43cb853c@linux</A>...</DIV>Make =
sure you=20
  run the setup app to install the scherzo drivers, reboot, <BR>then =
install=20
  Paris, reboot, then the effects subsystem, then reboot.&nbsp; I =
<BR>tried a=20
  bunch of optimizations listed below but for me I can track fine =
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<BR>but dx and=20
  vst plugins suck and crash with assertion errors and if I <BR>don't =
reboot a=20
  bsod follows.&nbsp; Guess we're back to=20
  win98se.<BR><BR>John<BR><BR><BR>musicxp.com tips<BR><BR>Processor =
Scheduling=20
  for Background Services<BR>Visual Effects for best =
performance<BR>Switch Off=20
  Desktop Background Image<BR&gt

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by rick on Sun, 01 Jan 2006 11:15:04 GMT
View Forum Message <> Reply to Message

tem with a fast
>>>>>>>>> computer. If you want to get off of the computer upgrade cycle,
they're
>>>>>>>> 
>>>>>>>>> available and they do what they do pretty well. But they aren't
>>>>>>>>> particularly upgradable and upgradability is a big draw for
>>>>>>>>> computer-based systems.
>>>>>>>>> 
>>>>>>>>> Computer-based systems that include separate DSP cards have some
>> of
>>>>> the
>>>>>>>> 
>>>>>>>>> advantages and upgrade costs of native systems and some of the
>>>>>>>>> disadvantages and limitations of dedicated, non-computer-based
systems.
>>>>>>>> 
>>>>>>>>> PARIS illustrates the disadvantages very well.
>>>>>>>>> 
>>>>>>>>> I bought an Intel computer for PARIS and bought an OS upgrade along
>>>>> the
>>>>>>>> 
>>>>>>>>> way. A few years later I bought a faster G4 computer for PARIS
and
>>>> it
>>>>>>>>> was a noticable improvement. I also bought an upgrade for the PARIS
>>>>>>>>> software which added useful new features and some unfinished, broken
>>>>>>>>> features. It was nice to be able to upgrade but it did cost money
>> just
>>>>>>> 
>>>>>>>>> as a native system would have. I was limited to the PARIS hardware
>>>>>>>>> running on OS9, and the developers dropped support.
>>>>>>>>> 
>>>>>>>>> PARIS would ne
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Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by uptown jimmy on Sun, 01 Jan 2006 17:34:03 GMT
View Forum Message <> Reply to Message

>>>>>>>> The folks on gearslutz will always be chasing ways to spend more
>>>> money
>>>>>>>> 
>>>>>>>>>>> on their systems (no matter what systems they have, native or
DSP).
>>>>>>>>>>> There's no real cure for that. :^)
>>>>>>>>>>> 
>>>>>>>>>>> It's true the Mac Intel transition will take time. It's not a
five
>>>>> year
>>>>>>>>>> 
>>>>>>>>>> 
>>>>>>>>>>> wait, though. Over the next six months there will likely be software
>>>>>>> 
>>>>>>>>>>> choices for audio production that run on both Intel and PPC,
probably
>>>>>>>> 
>>>>>>>>>>> starting with Logic around March/April as a $50 upgrade, so they
>>>> say.
>>>>>>>>>>> 
>>>>>>>>>>> Over the next year the Mac Intel hardware choices will expand
into
>>>>> more
>>>>>>>>>> 
>>>>>>>>>> 
>>>>>>>>>>> laptop and desktop choices as Intel's series of chips hit the
market.
>>>>>>>> 
>>>>>>>>>>> The roadmap is pretty much known at this point. If you want to
>> go
>>>>> with
>>>>>>>> 
>>>>>>>>>>> Intel, pick your best time for the transition.
>>>>>>>>>>> 
>>>>>>>>>>> If you want to make music using OSX right away there are plenty
>> of
>>>>> PPC
>>>>>>>> 
>>>>>>>>>>> choices that work today, all the way up to the quad PowerMac
which
>>>>> has
>>>>>>>> 
>>>>>>>>>>> more muscle than you probably need. Available now and they'll
>>>>>>>>>>> continue
>>>>>>>> 
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>>>>>>>>>>> to work after the Intel transition.
>>>>>>>>>>> 
>>>>>>>>>>> Cheers,
>>>>>>>>>>> -Jamie
>>>>>>>>>>> http://www.JamieKrutz.com
>>>>>>>>>>> 
>>>>>>>>>>> 
>>>>>>>>>>> LaMont wrote:
>>>>>>>>>>> 
>>>>>>>>>>>> Hi Guys, Some thoughts:
>>>>>>>>>>>> 
>>>>>>>>>>>> Has anyone noticed that since our beloved Paris DAW($2700list)there
>>>>>>> has
>>>>>>>>>> 
>>>>>>>>>> no
>>>>>>>>>> 
>>>>>>>>>>>> pro DAW for under 10k??? Why??
>>>>>>>>>>>> 
>>>>>>>>>>>> I know we have the Cubases ($499) Nuendo's ($1,500), Logic(1k),
>>>> DP(699)
>>>>>>>>>> 
>>>>>>>>>> &
>>>>>>>>>> 
>>>>>>>>>>>> Sonar($400). There are all very good naitive systems that will
>> yield
>>>>>>>> pro
>>>>>>>>>>>> results. However, I can't belive thatthere is not one manufacture
>>>>> other
>>>>>>>>>> 
>>>>>>>>>> than
>>>>>>>>>> 
>>>>>>>>>>>> Digidesign that want's to producer a DSP based DAW?? It's almost
>>>>> 6 years
>>>>>>>>>>>> since the plug was pulled on Paris! Yes, I did not forget about
>>>>>>>>>>>> Soundscape..
>>>>>>>>>>>> 
>>>>>>>>>>>> My Point in this post is to bring to ligh that Paris was a product
>>>>> that
>>>>>>>>>> 
>>>>>>>>>> served
>>>>>>>>>> 
>>>>>>>>>>>> the "Middle ground" studio. Now, looking back, it's price point
>>>> was
>>>>>>> revolutionary.
>>>>>>>>>>>> AND That's the point..
>>>>>>>>>>>> 
>>>>>>>>>>>> Today, if you're shelling out at least 10k for a PT HD system,
>> your
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>>>>>>> only
>>>>>>>>>>>> other alternative is do a naitive system..Again, I'm not saying
>>>> that
>>>>>>>> naitive's
>>>>>>>>>>>> are bad, but we all know that there's nothing like a cool DSP
>>>>>>>>>>>> DAW..Even
>>>>>>>>>> 
>>>>>>>>>> more,
>>>>>>>>>> 
>>>>>>>>>>>> it's a knwon fact that, if you wew to build your naitive system
>>>> up
>>>>> to
>>>>>>>>>> 
>>>>>>>>>> Pro
>>>>>>>>>> 
>>>>>>>>>>>> standards (AD/DA converters,mixer,DSP FX cards) you'd actually
>> come
>>>>>>> to
>>>>>>>>>> 
>>>>>>>>>> an
>>>>>>>>>> 
>>>>>>>>>>>> PT HD system.
>>>>>>>>>>>> There has to be a manufactuer that will stand up and fill in
the
>>>>> gap
>>>>>>>> between
>>>>>>>>>>>> PT HD & the Naitives. Any company has the balls??
>>>>>>>>>>>> 
>>>>>>>>>>>> Today my dream DAW would come from Mackie:
>>>>>>>>>>>> -The MAckie DBX digital mixer (Dual touch screens)that also
had
>>>> the
>>>>>>> capability
>>>>>>>>>>>> to record up to 128 24/96 audio tracks. Using the same cool
editing
>>>>>>> found
>>>>>>>>>>>> in their earlier Hard disk recorder MDR2496. The mix has the
>>>>>>>>>>>> capabilities
>>>>>>>>>>>> to add up to 3or 4 UAD cards, as well as third party FX for
the
>>>> mixer.
>>>>>>>>>> 
>>>>>>>>>>  This

Subject: Re: West Nile virus???-it looks pretty grim around here
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Posted by Deej [1] on Sun, 01 Jan 2006 20:06:14 GMT
View Forum Message <> Reply to Message

br />
>>>> 
>>>>> 
>>>>> This would be my idea of an optimized productivity scenario if I was
>> using
>>>>> Nuendo and had the budget.
>>>>> 
>>>>> http://www.arbitermt.co.uk/nuendo/products/idcontroller.htm
>>>>> 
>>>>> A bit pricey, but definitely specific to the application and with a
moose
>>>>> of a DAW running the software and DSP, a nice rack of Myteks or Lavry's
>>> for
>>>>> tracking and patching external processors, and a decent summing box,
>> I
>>> might
>>>>> be convinced to jump ship.
>>>>> 
>>>>> ;o)
>>>>> 
>>>>> 
>>>>> 
>>>>> "LaMont " <jjdpro@ameritech.net> wrote:
>>>>>> 
>>>>>> "Productivity is a matter of finding a system that does what you need
>>> what
>>>>>> I need may not be what you need and that could be the root of this
>>>>>> discussion)."
>>>>>> 
>>>>>> Agreed.. :) 
>>>>>> But, the rest of your post illustrates my points. Some Producer buddies
>>>>> of
>>>>>> mine in town, were having this same discusion about amonth or so ago.
>>> They
>>>>>> are all Mac user, with a few giga machines. The consesus for us all
>> is
>>> that
>>>>>> we have grown tired of the "upgrade" syndrome that, for one forces
the
>>>>>> non-computer
>>>>>> music guy to become so entrenched with personal computer technology,
>>> that
>>>>>> they can't focus on music..At the end of the conversation, we all
agreed
>>>>>> that having a system like Pro-Tools HD would "serve" us best with
out
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>>> having
>>>>>> to "think" or stay on the CPU upgrade "teadmill" if you will. I've
been
>>>>> on
>>>>>> that treadmill since 97,and as I look back on how many great working
>>> system
>>>>>> setups I've detroyed due becuase I was trying to play the CPU  sped
>> game.
>>>>>> I've lost decnet paying mixng and production jobs becuase my systems
>>> were
>>>>>> not as stable as I had them before I "upgraded" to a faster cpu and
>> OS..
>>>>>> I one of our suites we still have PT Mix cube running on a G4(450)
OS9
>>> that's
>>>>>> rock solid stable.. One of my Paris setup still has Win 98se..Stable
>>> stable
>>>>>> stable:)
>>>>>> 
>>>>>> 2 staff producers went chasing the Apple speed dream , from Dual 867s
>>> to
>>>>>> Dual G5(2.5s) on OSX..Man, the agony and frustrations on their faces
>>> due
>>>>>> to the fact that they had serious deadlines. That's what spurred our
>>>>>> conversations
>>>>>> about it's either PTHD or a slotion with DM2000/02r96 with Nuendo/PT
>>> Radar
>>>>>> with the yammy difital mixer.. Each set up cost. But, we demand a
solid
>>>>> working
>>>>>> system, that you do not have to make execues to yourself and the client..
>>>>>> 
>>>>>> Dedric may have said it best when he stated that doing a dedicated
dsp
>>> system
>>>>>> manybe a daughting task$$ Or so they say.. Stuff coming out of China
>>> (Phonic
>>>>>> firewire) mixers as well as microphones and other products are astounding
>>>>>> deals. Just maybe the solution I'm after will come from China?
>>>>>> LaMont
>>>>>> 
>>>>>> 
>>>>>> 
>>>>>> 
>>>>>> Jamie K <Meta@Dimensional.com> wrote:
>>>>>>> 
>>>>>>> Lamont wrote:
>>>>>>>> Hey Jaimie,
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>>>>>>>> 
>>>>>>>> Athough native cpus are fast, don't think that you are getting off
>>> cheap.
>>>>>>>> Playing the speed keep up game every 2 years is 1) not productive..2)
>>>>>> very
>>>>>>>> expensive.. think about it..??
>>>>>>> 
>>>>>>> Both native and DSP-based can be expensive. Native can be much less
>>>>>>> expensive though, if budget is limited. For example, on the low end
>>> a
>>>>>>> Mac Mini comes with Garage Band and you can do a lot with that and
>> an
>>>>>>> inexpensive Firewire or USB i/o box for a total cost of less than
$1000.
>>>>>>> 
>>>>>>> Productivity is a matter of finding a system that does what you need
>>>>>>> (what I need may not be what you need and that could be the root
of
>>> this
>>>>>> 
>>>>>>> discussion).
>>>>>>> 
>>>>>>> There are DSP-based systems out there that come with their own
>>>>>>> mixer/burner/software in a table-top format without requiring a
>>>>>>> computer. They cost as much or more as a native system with a fast
>>>>>>> computer. If you want to get off of the computer upgrade cycle, they're
>>>>>> 
>>>>>>> available and they do what they do pretty well. But they aren't
>>>>>>> particularly upgradable and upgradability is a big draw for
>>>>>>> computer-based systems.
>>>>>>> 
>>>>>>> Computer-based systems that include separate DSP cards have some
of
>>> the
>>>>>> 
>>>>>>> advantages and upgrade costs of native systems and some of the
>>>>>>> disadvantages and limitations of dedicated, non-computer-based systems.
>>>>>> 
>>>>>>> PARIS illustrates the disadvantages very well.
>>>>>>> 
>>>>>>> I bought an Intel computer for PARIS and bought an OS upgrade along
>>> the
>>>>>> 
>>>>>>> way. A few years later I bought a faster G4 computer for PARIS and
>> it
>>>>>>> was a noticable improvement. I also bought an upgrade for the PARIS
>>>>>>> software which added useful new features and some unfinished, broken
>>>>>>> features. It was nice to be able to upgrade but it did cost money
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just
>>>>> 
>>>>>>> as a native system would have. I was limited to the PARIS hardware
>>>>>>> running on OS9, and the developers dropped support.
>>>>>>> 
>>>>>>> PARIS would never get faster better, it was what it was. For me,
the
>>>>>>> freeze point in development stopped just short of what I needed.
Close,
>>>>>> 
>>>>>>> but forever short. So I sold it.
>>>>>>> 
>>>>>>> Meanwhile CPUs had gotten much, much faster and having separate DSP
>>> for
>>>>>> 
>>>>>>> the DAW had lost much of its advantage. I switched to a native system
>>>>>>> running on the same G4 computer I had purchased for PARIS, but using
>>>>>>> native software along with a new i/o box and a better operating system.
>>>>>> 
>>>>>>> The transition did not cost a lot overall and the sale of PARIS pretty
>>>>> 
>>>>>>> much covered it.
>>>>>>> 
>>>>>>> I did live on the bleeding edge for a while, though, with the transition
>>>>>> 
>>>>>>> to OSX and I had to try several Firewire interfaces to find a solid
>>> system.
>>>>>>> 
>>>>>>> After a few years I upgraded to a new computer but kept the software
>>> and
>>>>>> 
>>>>>>> i/o box I was already using. I sold the previous computer, so the
>>>>>>> upgrade cost was not high. I upgraded the native software and computer
>>>>> 
>>>>>>> OS several times and the increase in capability was worth the upgrade
>>>>>>> costs, just as it would have been with a DSP based system.
>>>>>>> 
>>>>>>> If I had to buy from scratch today, I'd either pick up a Quad PowerMac
>>>>> 
>>>>>>> or save a bunch of money and get a dual G5 PowerMac, add extra RAM
>> and
>>>>> 
>>>>>>> HD, Digital Performer or Logic, a Firewire i/o box or two and some
>> third
>>>>>> 
>>>>>>> party plugins. That system would probably last for the next ten years.
>>>>> 
>>>>>>> Even if I added a 24 moving fader controller it would be well under
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>>> 10K.
>>>>>> 
>>>>>>> Again, what I do and what you do may be different so your mileage
may
>>> vary.
>>>>>>> 
>>>>>>> My current 2.5GHZ dual G5 is fast enough that I don't feel the need
>>> to
>>>>> 
>>>>>>> upgrade it for audio production. It could go for the next decade
with
>>>>>>> slowing me down.
>>>>>>> 
>>>>>>> However if I decide to upgrade it at some point for animation or
video
>>>>> 
>>>>>>> production, the audio side will come along for the ride at no extra
>>> cost.
>>>>>>> 
>>>>>>> 
>>>>>>>> At least with a DSP based sytem, you know what you have, and the
native
>>>>>> cpu
>>>>>>>> is a secondary issue.
>>>>>>> 
>>>>>>> With the speed of CPUs today, why tie yourself to a hardware-limited
>>> DSP

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by uptown jimmy on Mon, 02 Jan 2006 00:54:18 GMT
View Forum Message <> Reply to Message

t;>>>>>>> Digidesign that want's to producer a DSP based DAW?? It's almost
>>> 6 years
>>>>>>>>>> since the plug was pulled on Paris! Yes, I did not forget about
>>>>>>>>>> Soundscape..
>>>>>>>>>> 
>>>>>>>>>> My Point in this post is to bring to ligh that Paris was a product
>>> that
>>>>>>>> 
>>>>>>>> served
>>>>>>>> 
>>>>>>>>>> the "Middle ground" studio. Now, looking back, it's price point
>> was
>>>>> revolutionary.
>>>>>>>>>> AND That's the point..
>>>>>>>>>> 
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>>>>>>>>>> Today, if you're shelling out at least 10k for a PT HD system,
your
>>>>> only
>>>>>>>>>> other alternative is do a naitive system..Again, I'm not saying
>> that
>>>>>> naitive's
>>>>>>>>>> are bad, but we all know that there's nothing like a cool DSP
>>>>>>>>>> DAW..Even
>>>>>>>> 
>>>>>>>> more,
>>>>>>>> 
>>>>>>>>>> it's a knwon fact that, if you wew to build your naitive system
>> up
>>> to
>>>>>>>> 
>>>>>>>> Pro
>>>>>>>> 
>>>>>>>>>> standards (AD/DA converters,mixer,DSP FX cards) you'd actually
come
>>>>> to
>>>>>>>> 
>>>>>>>> an
>>>>>>>> 
>>>>>>>>>> PT HD system.
>>>>>>>>>> There has to be a manufactuer that will stand up and fill in the
>>> gap
>>>>>> between
>>>>>>>>>> PT HD & the Naitives. Any company has the balls??
>>>>>>>>>> 
>>>>>>>>>> Today my dream DAW would come from Mackie:
>>>>>>>>>> -The MAckie DBX digital mixer (Dual touch screens)that also had
>> the
>>>>> capability
>>>>>>>>>> to record up to 128 24/96 audio tracks. Using the same cool editing
>>>>> found
>>>>>>>>>> in their earlier Hard disk recorder MDR2496. The mix has the
>>>>>>>>>> capabilities
>>>>>>>>>> to add up to 3or 4 UAD cards, as well as third party FX for the
>> mixer.
>>>>>>>> 
>>>>>>>>  This
>>>>>>>> 
>>>>>>>>>> would be a ground breaking product. Even though Tascam tried it,
>>> their
>>>>>>>> 
>>>>>>>> SX-1
>>>>>>>> 
>>>>>>>>>> was cool, but was too limited. Actualy, the SA-1 was a Ensoniq/EMU
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>>>>>>>>>> product
>>>>>>>>>> first, then made it's was over to Tascam..I digress..
>>>>>>>>>> I still hoping that the Yamaha/Steinberg marrige would yield a
very
>>>>> cool
>>>>>>>>>> DM2000 metts Nuendo or 02R-96 meets Cubase sx . All in one units..
>>>>>>>>>> 
>>>>>>>>>> As things stands now in our current state of Personal computers
>> based
>>>>>>>> 
>>>>>>>> DAW,
>>>>>>>> 
>>>>>>>>>> we really have not had any ground breaking technology save for
newer
>>>>>> faster
>>>>>>>>>> Cpus.. Inwhich, I for one am tired of chasing the speed demon.Enough
>>>>>> already..I
>>>>>>>>>> say this and I work as a IT Network Consultant.. Okay :) i digress
>>>>>>>>>> again..:)
>>>>>>>>>> 
>>>>>>>>>> 
>>>>>>>>>> I guess this post grew out of neverending post over on
>>>>>>>>>> www.gearslutz.com
>>>>>>>>>> about Ribbon mics, Summing buss's, 5k mics, 4k pre-amps, 4k
>>>>>>>>>> converters..
>>>>>>>>>> I'm thinking, why do I want to keep sinking good money into "dressing
>>>>>>>> 
>>>>>>>> up
>>>>>>>> 
>>>>>>>>>> a naitive DAW to try to sound as good as Paris does for (2,700.00
>>> Orginal
>>>>>>>>>> list)??? Those guys, bless their hearts are into dreaming that
if
>>> they
>>>>>>>> 
>>>>>>>> sink
>>>>>>>> 
>>>>>>>>>> another 5-10k in analoge summing gear, tey will have that magic
>> ssound..
>>>>>>>>>> So, I'm thinkink, 'Why have we gone backwards in this dAW game??
>>> Is
>>>>> it
>>>>>>>> 
>>>>>>>> that
>>>>>>>> 
>>>>>>>>>> Digi has such a strangle hold on the industry,that they can dictate
>>>>> jsut
>>>>>>>>>> how much cool stuff reaches the lowered of the spectrum. What
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I
>> mean
>>>>>> is
>>>>>>>> 
>>>>>>>> ,
>>>>>>>> 
>>>>>>>>>> PT LE is just enough to get frustrated to only dream and save
up
>>> for
>>>>>> HD..
>>>>>>>>>> 
>>>>>>>>>> 
>>>>>>>>>> Now, we have this Apple fiasco..New machines, with new CPUS, little
>>>>> software
>>>>>>>>>> support. do they really think that thisi was good move now?? I'm
>>> not
>>>>>> even
>>>>>>>>>> a current Mac owner and I agonise for MAc lovers and users. If
I
>>> were
>>>>>>>> 
>>>>>>>> them,
>>>>>>>> 
>>>>>>>>>> I would not upgrade for at leat 3-4 years. I digress again ..:)
>> Sorry.
>>>>>>>>>> 
>>>>>>>>>> Again, calling on all new and current manufactures..You a vast
market
>>>>>>>> 
>>>>>>>> of
>>>>>>>> 
>>>>>>>>>> Pro users and studios that needs more juice and pro features than
>>> your
>>>>>>>> 
>>>>>>>> current
>>>>>>>> 
>>>>>>>>>> offereing, but we don;t want to spend 20k for it.. Soemthing along
>>> say
>>>>>>>> 
>>>>>>>> 3-15k
>>>>>>>> 
>>>>>>>>>> would do it..
>>>>>>>>>> Okay end of rant..LaMont
>>>>>>>>>> 
>>>>>>>> 
>>>>>>>> 
>>>>>> 
>>>>> 
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>>>> 
>>> 
>> 
>La Mont,

I started noticing something sort of mushy in SX in the low end at around 24
tracks. It could very well be that I just don't know how to mix on a native
system though. Fire it over lightpipe into the Paris mixer and it gets big
again. I'm still summing in Paris and actually setting levels and fader/FX
automation on both DAWs. I'm getting basic fader moves done in SX and then
tweaking them in Paris. It's pretty wild to watch a mix happen here. I'm
using a fair amount of analog gear in my mixes. I've got 10 analog I/O in my
cubase DAw and I'm using them all for inserts of analog comps and EQ's. In
Paris, I'm patching in analog qand digital reverbs and delays. For a while I
was paranoid about signal degradation with this many AD/DA's. Now I don't
even think twice.

Last night Tony posted up a song that I mixed on his site.

 http://www.mercysakes.com/paris/Doug%20Joyce/Faith%20In%20Lo ve/

It's about finished, maybe a little more LF and vocal rebalancing and a
little de-essing that I'm going to add. There are 30 tracks-12 drum tracks,
vocal track, 15 acoustic instrument tracks and 3 x electric bass tracks.
They've got external processors all over them....10 x AD/DA's with analog
processors in cubase Sx and another 6 x AD/DA's in Paris, but I'm happy with
the mix......and what's most important, so is the client. It doesn't have
that linearness that I hear in PT, but we were going after a retro feel and
I think we achieved it. I think the Paris mix engine has a lot to do with it
all hanging together. It just doesn't sound at all the same if I sum it in
SX. Much smaller sounding. this mix has had no *mastering*, though NoLimit
was kissing the Paris mix bus.

Deej
..
"LaMont" <jjdpo@ameritech.net> wrote in message news:43cb2d79$1@linux...
>
> hey Dedric, a friend of mine has upgrade to Sonar5 and we can hear the
difference
> form version 4. Version 4 sound was very balnd , vanillia if you will.
version
> 5 mix summing sounds very wide, with more dept than version 4..So, they
did
> soemthing.
>
> Note: That's what I think Nuendos/SX weak point. in theory,their 32bit
floating
> point mixer/summing bus was to allow for more audio options up and down
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the
> audio bandwdith, but, things(mixes) start to fall apart at a certain
point.
> 32bit float is great for plugins, limited for summming with high track
counts.
> LaMont
>
> Dedric Terry <dterry@keyofd.net> wrote:
> >ID would be cool, even if it looks like a psychedelic video switching
mixer
> >from the 70's, but the reviews on functionality and increased
productivity
> >are rather convincing.  Price is a bit steep though.
> >
> >One of these wouldn't be bad either:
> >
> > http://www.euphonix.com/post/products/system_5-mc/system_5-m c.htm
> >
> >Or maybe,
> >
> >http://www.euphonix.com/post/products/mc/mc.htm
> >
> >That's Nuendo on screen in both links.
> >
> >This one still gets my vote for geek heaven and client wow factor:
> >
> >http://www.smartav.net/images/E72Splash1-1024x768.jpg
> >
> >
> >BTW - I'm guessing that if Steinberg gets the 64 bit update right with a
> 64
> >bit full audio path, summing boxes could be just another color in the
tool
> >palette, but far from necessary, and likely less spacious and clear, but
> >that's more optimism than guarantee.
> >
> >I would like to hear Sonar 5 in full 64-bit glory to see if 64-bit
(assuming
> >Cakewalk isn't blowing smoke) lives up the paper specs on the concept,
but
> >I'm hesitant to buy into the hype until proven sonically.
> >
> >Regards,
> >Dedric
> >
> >On 1/15/06 10:45 PM, in article 43cb24d5$1@linux, "Deej"
> ><hdfajkl@hjkal.buzzz> wrote:
> >
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> >>
> >> This would be my idea of an optimized productivity scenario if I was
using
> >> Nuendo and had the budget.
> >>
> >> http://www.arbitermt.co.uk/nuendo/products/idcontroller.htm
> >>
> >> A bit pricey, b

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by Deej [1] on Mon, 02 Jan 2006 01:42:13 GMT
View Forum Message <> Reply to Message

ris setup still has Win 98se..Stable
> stable
> >>> stable:)
> >>>
> >>> 2 staff producers went chasing the Apple speed dream , from Dual 867s
> to
> >>> Dual G5(2.5s) on OSX..Man, the agony and frustrations on their faces
> due
> >>> to the fact that they had serious deadlines. That's what spurred our
> >>> conversations
> >>> about it's either PTHD or a slotion with DM2000/02r96 with Nuendo/PT
> Radar
> >>> with the yammy difital mixer.. Each set up cost. But, we demand a
solid
> >> working
> >>> system, that you do not have to make execues to yourself and the
client..
> >>>
> >>> Dedric may have said it best when he stated that doing a dedicated dsp
> system
> >>> manybe a daughting task$$ Or so they say.. Stuff coming out of China
> (Phonic
> >>> firewire) mixers as well as microphones and other products are
astounding
> >>> deals. Just maybe the solution I'm after will come from China?
> >>> LaMont
> >>>
> >>>
> >>>
> >>>
> >>> Jamie K <Meta@Dimensional.com> wrote:
> >>>>
> >>>> Lamont wrote:
> >>>>> Hey Jaimie,
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> >>>>>
> >>>>> Athough native cpus are fast, don't think that you are getting off
> cheap.
> >>>>> Playing the speed keep up game every 2 years is 1) not
productive..2)
> >>> very
> >>>>> expensive.. think about it..??
> >>>>
> >>>> Both native and DSP-based can be expensive. Native can be much less
> >>>> expensive though, if budget is limited. For example, on the low end
> a
> >>>> Mac Mini comes with Garage Band and you can do a lot with that and an
> >>>> inexpensive Firewire or USB i/o box for a total cost of less than
$1000.
> >>>>
> >>>> Productivity is a matter of finding a system that does what you need
> >>>> (what I need may not be what you need and that could be the root of
> this
> >>>
> >>>> discussion).
> >>>>
> >>>> There are DSP-based systems out there that come with their own
> >>>> mixer/burner/software in a table-top format without requiring a
> >>>> computer. They cost as much or more as a native system with a fast
> >>>> computer. If you want to get off of the computer upgrade cycle,
they're
> >>>
> >>>> available and they do what they do pretty well. But they aren't
> >>>> particularly upgradable and upgradability is a big draw for
> >>>> computer-based systems.
> >>>>
> >>>> Computer-based systems that include separate DSP cards have some of
> the
> >>>
> >>>> advantages and upgrade costs of native systems and some of the
> >>>> disadvantages and limitations of dedicated, non-computer-based
systems.
> >>>
> >>>> PARIS illustrates the disadvantages very well.
> >>>>
> >>>> I bought an Intel computer for PARIS and bought an OS upgrade along
> the
> >>>
> >>>> way. A few years later I bought a faster G4 computer for PARIS and it
> >>>> was a noticable improvement. I also bought an upgrade for the PARIS
> >>>> software which added useful new features and some unfinished, broken
> >>>> features. It was nice to be able to upgrade but it did cost money
just
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> >>
> >>>> as a native system would have. I was limited to the PARIS hardware
> >>>> running on OS9, and the developers dropped support.
> >>>>
> >>>> PARIS would never get faster better, it was what it was. For me, the
> >>>> freeze point in development stopped just short of what I needed.
Close,
> >>>
> >>>> but forever short. So I sold it.
> >>>>
> >>>> Meanwhile CPUs had gotten much, much faster and having separate DSP
> for
> >>>
> >>>> the DAW had lost much of its advantage. I switched to a native system
> >>>> running on the same G4 computer I had purchased for PARIS, but using
> >>>> native software along with a new i/o box and a better operating
system.
> >>>
> >>>> The transition did not cost a lot overall and the sale of PARIS
pretty
> >>
> >>>> much covered it.
> >>>>
> >>>> I did live on the bleeding edge for a while, though, with the
transition
> >>>
> >>>> to OSX and I had to try several Firewire interfaces to find a solid
> system.
> >>>>
> >>>> After a few years I upgraded to a new computer but kept the software
> and
> >>>
> >>>> i/o box I was already using. I sold the previous computer, so the
> >>>> upgrade cost was not high. I upgraded the native software and
computer
> >>
> >>>> OS several times and the increase in capability was worth the upgrade
> >>>> costs, just as it would have been with a DSP based system.
> >>>>
> >>>> If I had to buy from scratch today, I'd either pick up a Quad
PowerMac
> >>
> >>>> or save a bunch of money and get a dual G5 PowerMac, add extra RAM
and
> >>
> >>>> HD, Digital Performer or Logic, a Firewire i/o box or two and some
third
> >>>
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> >>>> party plugins. That system would probably last for the next ten
years.
> >>
> >>>> Even if I added a 24 moving fader controller it would be well under
> 10K.
> >>>
> >>>> Again, what I do and what you do may be different so your mileage may
> vary.
> >>>>
> >>>> My current 2.5GHZ dual G5 is fast enough that I don't feel the need
> to
> >>
> >>>> upgrade it for audio production. It could go for the next decade with
> >>>> slowing me down.
> >>>>
> >>>> However if I decide to upgrade it at some point for animation or
video
> >>
> >>>> production, the audio side will come along for the ride at no extra
> cost.
> >>>>
> >>>>
> >>>>> At least with a DSP based sytem, you know what you have, and the
native
> >>> cpu
> >>>>> is a secondary issue.
> >>>>
> >>>> With the speed of CPUs today, why tie yourself to a hardware-limited
> DSP
> >>>
> >>>> system. If the company you buy it from is in business in five years,
> the
> >>>
> >>>> cost to upgrade a system like that could be much higher than just
buying
> >>>
> >>>> a newer, faster computer.
> >>>>
> >>>> And when you buy a newer, faster computer you are upgrading
everything
> >>
> >>>> that runs on it, all your plugins, virtual instruments, even other
> >>>> software (graphics, animation, video editing, software development,
> >>>> whatever else you do), in one shot.
> >>>>
> >>>>
> >>>> Plus, low latency, better i/o integration in a pro
> >>>>> enviorment..
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> >>>>
> >>>> This is your best argument. But latency is not an issue in my current
> >>>> setup. My i/o box has direct monitoring. Even if I monitor through
Logic
> >>>
> >>>> the latency is low enough that it hasn't been a problem.
> >>>>
> >>>> The i/o integration is fine, I have 18 analog inputs and 16 analog
> >>>> outputs plus stereo digital i/o directly patchable through my DAW
> >>>> software and also routable from the i/o box's monitoring software. If
> I
> >>>
> >>>> need more i/o I can plug in another Firewire i/o box.
> >>>>
> >>>> I run my system with a mouse and a jog/shuttle wheel add-on. I can
get
> >>
> >>>> moving fader controllers from at least four different manufacturers
> >>>> which is tempting, but since I only really used the jog/shuttle part
> of
> >>>
> >>>> the PARIS controller I haven't needed that. Plus I've grown used to
> the
> >>>
> >>>> precision and (believe it or not) speed of mixing with the mouse.
> >>>>
> >>>>
> >>>> The sad truth with moast if not all native solutios is that
> >>>>> it has forced a big$$$ third party solutions market, inwhic native
> users
> >>>>> are going back to purchase , talk back units, better than average
> >>>>> converters..All
> >>>>> to chase the dsp systems way of working..in the end, the native
person
> >>> does
> >>>>> not realize that they have spent just as much, if not more than they
> >> could've
> >>>>> gotten with a dsp based DAW.
> >>>>
> >>>> A native system will be more flexible, you'll have more developers to
> >>>> choose from to enhance your system, and if one of the developers goes
> >>>> under, your system will not hit a dead end.
> >>>>
> >>>> Over the last decade I've spent way less than, for example, a
ProTools
> >>
> >>>> system would have cost and am getting, I think, comparable results.
> >>>>
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> >>>>
> >>>>> Having used nuendo sice it's inception (2000, ),logic audio, Ican
with
> >>> hesitation,
> >>>>> that it takes a lot of $$$ to bring those apps up to pro specs, and
> truth
> >>>>> be known, steinbergs way of integrating hardware leaves a lot to be
> >>>>> desired..
> >>>>
> >>>> A Quad PowerMac with extra RAM and HD, MOTU Digital Performer, a MOTU
> >>>> Firewire i/o box or two and some third party plugins...even a 24
moving
> >>>
> >>>> fader controller and you're well under 10K.
> >>>>
> >>>> It all comes down to individual needs and preferences, so I'm not
really
> >>>
> >>>> saying you're wrong for what you're looking for. But for what I'm
> >>>> looking for, a native system is pretty compelling.
> >>>>
> >>>> OTOH, had PARIS MIDI support been better, had they hung around long
> >>>> enough to support OSX and AU plugins, I'd still be using PARIS. Even
> >>>> with the limitation of 44.1 or 48 sampling.
> >>>>
> >>>> Cheers,
> >>>>  -Jamie
> >>>>  http://www.JamieKrutz.com
> >>>>
> >>>>
> >>>>
> >>>>
> >>>>> Take care,
> >>>>> Lamont
> >>>>> take care
> >>>>>
> >>>>> Jamie K <Meta@Dimensional.com> wrote:
> >>>>>
> >>>>>> I dunno. Why lock into developing a new DSP system when native CPUs
> are
> >>>>>
> >>>>>
> >>>>>> so fast now (fast enough for tons of tracks/plugins) and just
getting
> >>>
> >>>>>> faster?
> >>>>>>
> >>>>>> The folks on gearslutz will always be chasing ways to spend more
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money
> >>>
> >>>>>> on their systems (no matter what systems they have, native or DSP).
> >>>>>> There's no real cure for that. :^)
> >>>>>>
> >>>>>> It's true the Mac Intel transition will take time. It's not a five
> year
> >>>>>
> >>>>>
> >>>>>> wait, though. Over the next six months there will likely be
software
> >>
> >>>>>> choices for audio production that run on both Intel and PPC,
probably
> >>>
> >>>>>> starting with Logic around March/April as a $50 upgrade, so they
say.
> >>>>>>
> >>>>>> Over the next year the Mac Intel hardware choices will expand into
> more
> >>>>>
> >>>>>
> >>>>>> laptop and desktop choices as Intel's series of chips hit the
market.
> >>>
> >>>>>> The roadmap is pretty much known at this point. If you want to go
> with
> >>>
> >>>>>> Intel, pick your best time for the transition.
> >>>>>>
> >>>>>> If you want to make music using OSX right away there are plenty of
> PPC
> >>>
> >>>>>> choices that work today, all the way up to the quad PowerMac which
> has
> >>>
> >>>>>> more muscle than you probably need. Available now and they'll
continue
> >>>
> >>>>>> to work after the Intel transition.
> >>>>>>
> >>>>>> Chee

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by jef knight[1] on Mon, 02 Jan 2006 15:50:12 GMT
View Forum Message <> Reply to Message
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br />
> rather than the technical solution, but it still might be quicker than
> trying to find the problem.
>
> You could also check to be sure another instance isn't running (i.e. still
> trying to send) - I don't know how that would happen after a reboot, but
> with some crashed apps, it might be possible.
>
> Dedric
>
> On 1/16/06 11:30 AM, in article 43cbd841$1@linux, "Deej"
<animix@animas.net>
> wrote:
>
> >
> > The other day I was trying to send an MP3 to Tony Benson. I screwed up
and
> > attached a .wav file instead. Instead of letting it upload until it
crapped
> > out, I cancelled the send in Outlook express. Afterwards my comp locked
up
> > so I did a hard reboot.
> > Then things went really wierd. For a while I couldn't open my Sent
Messages
> > folder. I got that working buty now, when I try to send a message to the
> > NG or anywhere else, I get the following message:
> >
> > Folder could not be displayed
> > Outlook Express could not open this folder.
> >
>
>  ------------------------------------------------------------ --------------
----
> > --
> >
> > Possible causes are:
> >
> > Low disk space.
> >
> > Low memory.
> >
> > Outlook Express
> >
> > I'm running 512MB of RAM and I've got plenty of disk space. I've also
got
> > other E-Mial identities in OE that are working properly. It's just this
one
> > that is messed up.
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> >
> > Any of you IT guys have a clue what is wrong here? I sure don't.
> >
> > Thanks,
> >
> > Deej
> >
>Well........after a couple of weeks of ordering VSTis' registering them and
burning in my new DAW, I'm getting ready to go in and optimize the OS and
turn off all nonessential services.

One wierdness about all of this is that windows will only *see* 3.14+-G of
RAM, even though I have 4G installed.

Jorsi posted up a tweak to allow more RAM to be accessed. I'm thinking that
this tweak will need to be done for the .exe files of Cubase SX as well as
all other .exe files (my VSTi's in particular) if I want them to be able to
access as much available RAM as possible.

Also, in the instructions I was provided, there are a bunch of  quotation
marks in the command lines, as follows:

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by Deej [1] on Mon, 02 Jan 2006 16:48:16 GMT
View Forum Message <> Reply to Message

e in message
>news:43cbf2fd$1@linux...
>> Well........after a couple of weeks of ordering VSTis' registering them
>and
>> burning in my new DAW, I'm getting ready to go in and optimize the OS and
>> turn off all nonessential services.
>>
>> One wierdness about all of this is that windows will only *see* 3.14+-G of
>> RAM, even though I have 4G installed.
>>
>> Jorsi posted up a tweak to allow more RAM to be accessed. I'm thinking
>that
>> this tweak will need to be done for the .exe files of Cubase SX as well as
>> all other .exe files (my VSTi's in particular) if I want them to be able
>to
>> access as much available RAM as possible.
>>
>> Also, in the instructions I was provided, there are a bunch of  quotation
>> marks in the command lines, as follows:
>>
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>> 1. Download masm32 (http://www.masm32.com/) and install it (after it
>> installs, it brings up a command prompt window, just close it. Do NOT have
>> it perform any of those functions.)
>> 2. Copy the Nuendo3.exe to another location for backup purposes
>> 3. Place another copy of Nuendo3.exe (or whichever sequencer you use) in
>the
>> C:\masm32\bin directory
>> 4. Open up your command prompt and type "cd c:\masm32\bin"
>> 5. Type "editbin /largeaddressaware Nuendo3.exe"
>> 6. Move the copy of the Nuendo3.exe file you just modified back to the
>> regular Nuendo directory
>> 7. Open your boot.ini file (located in C: - you may have to open any
>folder
>> and go Tools->Folder Options->View->Select Show Hidden Files and Folders
>and
>> UNcheck the "Hide protected operating system files" to see this file)
>> 8. Add "/3GB" after "multi(0)disk(0)rdisk(0)partition(2)\WINDOWS..." so it
>> should look like similar to
>> "multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP
>> Professional" /3GB /fastdetect...."
>> 9. If you have a UAD-1 card, you also need to add "/Userva=2900" after the
>> /3GB switch, so it should look like similar to
>> "multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP
>> Professional" /3GB /Userva=2900 /fastdetect...."
>> 10. Save the modified boot.ini file
>> 11. Reboot
>>
>> I'm assuming that the quotation marks are part of the command line at this
>> point and not just an emphasis as to exactly what to type (sans the
>> quotation marks)
>>
>> Prepare yourselves for occasional whining, grnashing of garments, rending
>of
>> teeth.......etc.
>>
>> ;o)
>>
>>
>"Deej" <animix@animas.net> wrote:
>
>The other day I was trying to send an MP3 to Tony Benson. I screwed up

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by jef knight[1] on Mon, 02 Jan 2006 17:28:04 GMT
View Forum Message <> Reply to Message

; Well........after a couple of weeks of ordering VSTis' registering them
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> >and
> >> burning in my new DAW, I'm getting ready to go in and optimize the OS
and
> >> turn off all nonessential services.
> >>
> >> One wierdness about all of this is that windows will only *see* 3.14+-G
of
> >> RAM, even though I have 4G installed.
> >>
> >> Jorsi posted up a tweak to allow more RAM to be accessed. I'm thinking
> >that
> >> this tweak will need to be done for the .exe files of Cubase SX as well
as
> >> all other .exe files (my VSTi's in particular) if I want them to be
able
> >to
> >> access as much available RAM as possible.
> >>
> >> Also, in the instructions I was provided, there are a bunch of
quotation
> >> marks in the command lines, as follows:
> >>
> >> 1. Download masm32 (http://www.masm32.com/) and install it (after it
> >> installs, it brings up a command prompt window, just close it. Do NOT
have
> >> it perform any of those functions.)
> >> 2. Copy the Nuendo3.exe to another location for backup purposes
> >> 3. Place another copy of Nuendo3.exe (or whichever sequencer you use)
in
> >the
> >> C:\masm32\bin directory
> >> 4. Open up your command prompt and type "cd c:\masm32\bin"
> >> 5. Type "editbin /largeaddressaware Nuendo3.exe"
> >> 6. Move the copy of the Nuendo3.exe file you just modified back to the
> >> regular Nuendo directory
> >> 7. Open your boot.ini file (located in C: - you may have to open any
> >folder
> >> and go Tools->Folder Options->View->Select Show Hidden Files and
Folders
> >and
> >> UNcheck the "Hide protected operating system files" to see this file)
> >> 8. Add "/3GB" after "multi(0)disk(0)rdisk(0)partition(2)\WINDOWS..." so
it
> >> should look like similar to
> >> "multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP
> >> Professional" /3GB /fastdetect...."
> >> 9. If you have a UAD-1 card, you also need to add "/Userva=2900" after
the
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> >> /3GB switch, so it should look like similar to
> >> "multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP
> >> Professional" /3GB /Userva=2900 /fastdetect...."
> >> 10. Save the modified boot.ini file
> >> 11. Reboot
> >>
> >> I'm assuming that the quotation marks are part of the command line at
this
> >> point and not just an emphasis as to exactly what to type (sans the
> >> quotation marks)
> >>
> >> Prepare yourselves for occasional whining, grnashing of garments,
rending
> >of
> >> teeth.......etc.
> >>
> >> ;o)
> >>
> >>
> >
>Here's more detail if it is needed....

Enable "Show Instrument Assignment"  in the mixer window settings menu.
In Editor Window, enable Settings / "Show Object Instruments"

Using Free-form mode.   I comp as I go along, or I'll just have the 
singer do four or five takes and then start comping.  I never switch it 
back to constrained mode, so when I'm mixing and I want to change 
something I know what I did and what my options are.

As for harmony parts and doubles,  I connect my mic to multiple 
different ch

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by Deej [1] on Mon, 02 Jan 2006 17:54:40 GMT
View Forum Message <> Reply to Message

7794" target="_blank"> http://video.google.com/videoplay?docid=-6553260189868317794
>You are probably set up as "standard pc" instead of ACPI... this also 
affects shut-down.

David.

Tony Benson wrote:
> This is old, old, old Jef. Also, totally contrary to any experience I've had 
> with the numerous Macs I've owned. Actually, some of the things he talks 

Page 31 of 37 ---- Generated from The PARIS Forums

https://paris.ensoniq.ca/index.php?t=usrinfo&id=481
https://paris.ensoniq.ca/index.php?t=rview&th=9622&goto=62220#msg_62220
https://paris.ensoniq.ca/index.php?t=post&reply_to=62220
https://paris.ensoniq.ca/index.php


> about I've only experienced on my PC's! The PC I'm typing this on right now 
> absolutely refuses to shut down. The screen comes up saying it's shutting 
> down, but days later it's still hasn't shut down. Anyone have any ideas on 
> this?
> 
> Tony
> 
> 
> "jef knight" <thestudio@allknightmusic.com> wrote in message 
> news:43cd146b$1@linux...
> 
>>this guy's really trashing his mac....a tad funny
>>
>> http://video.google.com/videoplay?docid=-6553260189868317794
>>
> 
> 
>How do I change this? Remember to talk slow and use detail if I have to go 
into the Bios or do anything complicated to fix this. I'm a Mac guy at heart 
and digging around in the bowels of a PC is scary for me.  ;>)

The weird thing is, it just started doing this a few months ago. Before 
that, it shut down fine.

Tony

"EK Sound" <spamnot.info@eksoundNO.com> wrote in message 
news:43cd23ea@linux...
> You are probably set up as "standard pc" instead of ACPI... this also 
> affects shut-down.
>
> David.
>
> Tony Benson wrote:
>> This is old, old, old Jef. Also, totally contrary to any experience I've 
>> had with the numerous Macs I've owned. Actually, some of the things he 
>> talks about I've only experienced on my PC's! The PC I'm typing this on 
>> right now absolutely refuses to shut down. The screen comes up saying 
>> it's shutting down, but days later it's still hasn't shut down. Anyone 
>> have any ideas on this?
>>
>> Tony
>>
>>
>> "jef knight" <thestudio@allknightmusic.com> wrote in message 
>> news:43cd146b$1@linux...
>>
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>>>this guy's really trashing his mac....a tad funny
>>>
>>> http://video.google.com/videoplay?docid=-6553260189868317794
>>>
>>
>>"Edric" <seboriah@juno.com> wrote:
> Would someone care to send me a copy of the original
> Paris ASIO driver (I think it's around 29kb in size)?

You can always find a copy at my Paris FAQs website...

--
-Doug

http://www.parisfaqs.comWhat version of windows??

David.

Tony Benson wrote:

> How do I change this? Remember to talk slow and use detail if I have to go 
> into the Bios or do anything complicated to fix this. I'm a Mac guy at heart 
> and digging around in the bowels of a PC is scary for me.  ;>)
> 
> The weird thing is, it just started doing this a few months ago. Before 
> that, it shut down fine.
> 
> Tony
> 
> 
> "EK Sound" <spamnot.info@eksoundNO.com> wrote in message 
> news:43cd23ea@linux...
> 
>>You are probably set up as "standard pc" instead of ACPI... this also 
>>affects shut-down.
>>
>>David.
>>
>>Tony Benson wrote:
>>
>>>This is old, old, old Jef. Also, totally contrary to any experience I've 
>>>had with the numerous Macs I've owned. Actually, some of the things he 
>>>talks about I've only experienced on my PC's! The PC I'm typing this on 
>>>right now absolutely refuses t

Subject: Re: West Nile virus???-it looks pretty grim around here
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Posted by zornwil on Mon, 02 Jan 2006 21:13:45 GMT
View Forum Message <> Reply to Message

t;>>> 
>>>>>>>> moving fader controllers from at least four different manufacturers
>>>>>>>> which is tempting, but since I only really used the jog/shuttle
part
>>>> of
>>>>>>> 
>>>>>>>> the PARIS controller I haven't needed that. Plus I've grown used
>to
>>>> the
>>>>>>> 
>>>>>>>> precision and (believe it or not) speed of mixing with the mouse.
>>>>>>>> 
>>>>>>>> 
>>>>>>>> The sad truth with moast if not all native solutios is that
>>>>>>>>> it has forced a big$$$ third party solutions market, inwhic native
>>>> users
>>>>>>>>> are going back to purchase , talk back units, better than average
>>>>>>>>> converters..All
>>>>>>>>> to chase the dsp systems way of working..in the end, the native
>person
>>>>>>> does
>>>>>>>>> not realize that they have spent just as much, if not more than
>they
>>>>>> could've
>>>>>>>>> gotten with a dsp based DAW.
>>>>>>>> 
>>>>>>>> A native system will be more flexible, you'll have more developers
>>> to
>>>>>>>> choose from to enhance your system, and if one of the developers
>goes
>>>>>>>> under, your system will not hit a dead end.
>>>>>>>> 
>>>>>>>> Over the last decade I've spent way less than, for example, a ProTools
>>>>>> 
>>>>>>>> system would have cost and am getting, I think, comparable results.
>>>>>>>> 
>>>>>>>> 
>>>>>>>>> Having used nuendo sice it's inception (2000, ),logic audio, Ican
>>> with
>>>>>>> hesitation,
>>>>>>>>> that it takes a lot of $$$ to bring those apps up to pro specs,
>and
>>>> truth
>>>>>>>>> be known, steinbergs way of integrating hardware leaves a lot to
>be
>>>>>>>>> desired..
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>>>>>>>> 
>>>>>>>> A Quad PowerMac with extra RAM and HD, MOTU Digital Performer, a
>MOTU
>>>>>>>> Firewire i/o box or two and some third party plugins...even a 24
>moving
>>>>>>> 
>>>>>>>> fader controller and you're well under 10K.
>>>>>>>> 
>>>>>>>> It all comes down to individual needs and preferences, so I'm not
>really
>>>>>>> 
>>>>>>>> saying you're wrong for what you're looking for. But for what I'm
>>>>>>>> looking for, a native system is pretty compelling.
>>>>>>>> 
>>>>>>>> OTOH, had PARIS MIDI support been better, had they hung around long
>>>>&g

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by TCB on Tue, 03 Jan 2006 00:10:04 GMT
View Forum Message <> Reply to Message

gt;>>> 
>>>>>>  http://www.euphonix.com/post/products/system_5-mc/system_5-m c.htm
>>>>>> 
>>>>>> Or maybe,
>>>>>> 
>>>>>> http://www.euphonix.com/post/products/mc/mc.htm
>>>>>> 
>>>>>> That's Nuendo on screen in both links.
>>>>>> 
>>>>>> This one still gets my vote for geek heaven and client wow factor:
>>>>>> 
>>>>>> http://www.smartav.net/images/E72Splash1-1024x768.jpg
>>>>>> 
>>>>>> 
>>>>>> BTW - I'm guessing that if Steinberg gets the 64 bit update right
with
>>>> a
>>>>> 64
>>>>>> bit full audio path, summing boxes could be just another color in
the
>>tool
>>>>>> palette, but far from necessary, and likely less spacious and clear,
>>but
>>>>>> that's more optimism than guarantee.
>>>>>> 
>>>>>> I would like to hear Sonar 5 in full 64-bit glory to see if 64-bit
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>(assuming
>>>>>> Cakewalk isn't blowing smoke) lives up the paper specs on the concept,
>>>> but
>>>>>> I'm hesitant to buy into the hype until proven sonically.
>>>>>> 
>>>>>> Regards,
>>>>>> Dedric
>>>>>> 
>>>>>> On 1/15/06 10:45 PM, in article 43cb24d5$1@linux, "Deej"
>>>>>> <hdfajkl@hjkal.buzzz> wrote:
>>>>>> 
>>>>>>> 
>>>>>>> This would be my idea of an optimized productivity scenario if I
was
>>>> using
>>>>>>> Nuendo and had the budget.
>>>>>>> 
>>>>>>> http://www.arbitermt.co.uk/nuendo/products/idcontroller.htm
>>>>>>> 
>>>>>>> A bit pricey, but definitely specific to the application and with
>a
>>moose
>>>>>>> of a DAW running the software and DSP, a nice rack of Myteks or Lavry's
>>>>> for
>>>>>>> tracking and patching external processors, and a decent summing box,
>>>> I
>>>>> might
>>>>>>> be convinced to jump ship.
>>>>>>> 
>>>>>>> ;o)
>>>>>>> 
>>>>>>> 
>>>>>>> 
>>>>>>> "LaMont " <jjdpro@ameritech.net> wrote:
>>>>>>>> 
>>>>>>>> "Productivity is a matter of finding a system that does what you
>need
>>>>> what
>>>>>>>> I need may not be what you need and that could be the root of this
>>>>>>>> discussion)."
>>>>>>>> 
>>>>>>>> Agreed.. :) 
>>>>>>>> But, the rest of your post illustrates my points. Some Producer
buddies
>>>>>>> of
>>>>>>>> mine in town, were having this same discusion about amonth or so
>ago.
>>>>> They
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>>>>>>>> are all Mac user, with a few giga machines. The consesus for us
all
>>>> is
>>>>> that
>>>>>>>> we have grown tired of the "upgrade" syndrome that, for one forces
>>the
>>>>>>>> non-computer
>>>>>>>> music guy to become so entrenched with personal computer technology,

Subject: Re: West Nile virus???-it looks pretty grim around here
Posted by uptown jimmy on Tue, 03 Jan 2006 02:15:34 GMT
View Forum Message <> Reply to Message

 that you do not have to make execues to yourself and the
> client..
>>>>>>>>
>>>>>>>> Dedric may have said it best when he stated that doing a dedicated
>>dsp
>>>>> system
>>>>>>>> manybe a daughting task$$ Or so they say.. Stuff coming out of 
>>>>>>>> China
>>>>> (Phonic
>>>>>>>> firewire) mixers as well as microphones and other products are 
>>>>>>>> astounding
>>>>>>>> deals. Just maybe the solutio
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